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PerfectOffice Standard
Software License Agreement

Introduction
The PerfectOffice suite and accompanying documentation

(respectively “Software” and “Documentation”) you have acquired

are protected by the copyright laws of the United States and

international copyright treaties. In addition, the possession and use
of the Software and Documentation is subject to the restrictions

contained in this License.

The component programs included in the PerfectOffice suite contain

various computer programs or files with different license rights. The

type of license that applies depends on the following definitions and
the permitted uses specified in the documentation accompanying the

Software. If this Software is an upgrade from a previous version of a

Novell software product, you may use either the current or prior

version of the Software, but never both versions at the same time. If
you use the current version, this License supersedes any prior version

license and governs your use of the Software. You may not transfer

the prior version separately from the current version without

permission from Novell.

Definitions
ENVOY VIEWER AND DRIVER means the Driver that enables you
to create Envoy file forms from within other applications and the

Envoy Viewer that allows you to view and manipulate the Envoy file

forms.

ENVOY RUNTIME VIEWER means the viewer that when linked

with an Envoy file form enables a user to view the Envoy file form.

License Grants
WordPerfect, Quattro Pro, InfoCentral, Envoy Viewer and
Driver, and Gateways
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive right to make and use up to the
number of copies of the Software and Documentation corresponding

to the “Quantity” designation on the Proof of Purchase form you

received in your PerfectOffice package.

Envoy Runtime Viewer
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive, royalty-free license to
distribute the Envoy Runtime Viewer as incorporated into an Envoy

file form developed using the Envoy Viewer and Driver, provided (a)

you do not use the logo, name or trademarks of Novell, (b) include a

valid copyright notice on media containing the Envoy Runtime
Viewer, and (c) agree to indemnify, defend and hold Novell and its

licensors harmless from and against any claims or lawsuits that arise

or result from use or distribution of the Envoy Runtime Viewer as

part of the Envoy file forms that you distribute. You are responsible
for all primary technical support to the end-users of any Envoy

Runtime Viewer you distribute. Envoy Runtime Viewer end-users

may receive technical support from Novell by calling 1-900-555-

7373. You may not reproduce or distribute the Envoy Viewer
without first purchasing the Envoy Commercial Publishing Pack.

GroupWise Client
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive right to (a) provided you do not

receive any direct payment, to make and distribute internally within

your organization an unlimited number of copies of the GroupWise
Client Software, and (b) use such copies of the GroupWise Client

Software to address and manipulate up to the number of mailboxes

corresponding to the “Quantity” designation on the Proof of Purchase

form you received in your PerfectOffice package.

GroupWise Message Server Software
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive right to (a) provided you do not

receive any direct payment, to make and distribute internally within
your organization an unlimited number of copies of the GroupWise

Message Server Software, and (b) use such copies to provide

GroupWise message services for a up to the number of domains

corresponding to the “Quantity” designation on the Proof of Purchase
form you received in your PerfectOffice package. A “domain” is a

logical grouping of post offices and/or gateways serviced by a single

message server.

General Provisions
Renting, Leasing, Timesharing & Reverse Engineering
You may not rent, lease, loan or timeshare the Software without the

prior written permission of Novell. You may not decompile,

disassemble, reverse engineer, or otherwise reduce the Software to a

human-perceivable form. You may not create or distribute the
Software or derivative works of the Software except as specifically

provided in this License.
Irrespective of the number of sets of media included with the
Software, you are granted the right to use the Software only

according the provisions of this License and the Proof of Purchase

form you have purchased. Certain qualifications may apply to the

purchase of this Software; when present, they are printed on the
Software package and form part of this License.

Home or Portable Computer Provision
You are authorized to use a copy of the Software on a home or

portable computer, as long as the extra copy is never loaded in

memory or virtual memory (Loaded) at the same time the Software is

Loaded on the primary computer on which you use the Software. If
you have licensed this Software under an education or charitable

institution pricing program, you may not create an extra copy of the

Software under this provision for use on a home or portable

computer.

Customer Support
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request

concerning the Software; however, this service is offered on a

reasonable efforts basis only, and Novell may not be able to resolve

every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is

designed. Current support policies may change from time to time

without notice.

Term
This License will become effective on the date you acquire the

Software and will remain in force until terminated. You may
terminate this License at any time by destroying the Documentation

and the Software together with all copies and adaptations. This

License shall also automatically terminate if you breach any of the

terms or conditions. You agree to destroy the original and all
adaptations or copies of the Software and Documentation, or to

return them to Novell upon termination of this License.
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Entire License
This License sets forth the entire understanding and License between

you and Novell and may be amended only in a writing signed by both

parties. NO VENDOR, DISTRIBUTOR, DEALER, RETAILER,
SALES PERSON OR OTHER PERSON IS AUTHORIZED TO

MODIFY THIS LICENSE OR TO MAKE ANY WARRANTY,

REPRESENTATION OR PROMISE WHICH IS DIFFERENT

THAN, OR IN ADDITION TO, THE REPRESENTATIONS OR
PROMISES OF THIS LICENSE.

Waiver
No waiver of any right under this License shall be effective unless in

writing, signed by a duly authorized representative of the party to be

bound. No waiver of any past or present right arising from any

breach or failure to perform shall be deemed to be a waiver of any
future right arising under this License.

Severability
If any provision in this License is invalid or unenforceable, that

provision shall be construed, limited, modified or, if necessary,

severed, to the extent necessary, to eliminate its invalidity or

unenforceability, and the other provisions of this License shall
remain unaffected.

Export
Novell can only make the Software available pursuant to a valid

export license. Consequently, Novell will refund any fees paid to

you if it is unable to obtain an export license to ship the Software to
you. Your sole remedy for Novell's failure to obtain an export

license is a refund. You hereby agree that you will not knowingly,

directly or indirectly, without prior written consent, if required, of the

Office of Export Licensing of the U.S. Department of Commerce,
Washington D.C. 20230, download, export, transmit or transfer the

Software or materials obtained via the Service to any group Q, S, W,

Y, or Z country specified in the Export Administration Regulations

issued by the U.S. Department of Commerce or to any country to
which such transmission is restricted by applicable regulations or

statutes.

US Government Restricted Rights
The Software and any accompanying materials are provided with

Restricted Rights. Use, duplication, or disclosure by the Government

is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The
Rights in Technical Data and Computer Software clause at DFARS

252.227-7013 or subparagraphs (c) (1) and (2) of the Commercial

Computer Software—Restricted Rights at 48 CFR 52.227-19, as

applicable. Contractor/manufacturer is Novell, Inc. at the address
below.

Questions?
If you have any questions concerning the terms of this License or

special programs for education or charitable organizations, please

write to WordPerfect, Novell Applications Group, Attn. Sales Center,

1555 N. Technology Way, Orem, Utah 84057-2399.
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Limited Warranty

This Software is licensed AS IS. If for any reason you are
dissatisfied with the software, return the product package, with proof

of purchase, to your reseller within 90 days for a full refund. If any

materials or media in this package are defective, return them to

Novell within 90 days of the date of purchase, and they will be
replaced at no charge. This refund is not available if the Software is

purchased as part of a Novell/Original Equipment Manufacturer

bundle.

THE SOFTWARE IS NOT DESIGNED, MANUFACTURED OR

INTENDED FOR USE OR RESALE FOR ON-LINE CONTROL
EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING

FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION

OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR

AIRCRAFT COMMUNICATION SYSTEMS, AIR TRAFFIC
CONTROL, DIRECT LIFE SUPPORT MACHINES, OR

WEAPONS SYSTEMS, IN WHICH FAILURE OF THE

SOFTWARE COULD LEAD DIRECTLY TO DEATH,

PERSONAL INJURY, OR SEVERE PHYSICAL OR
ENVIRONMENT DAMAGE.

THE SOFTWARE IS ONLY COMPATIBLE WITH CERTAIN

COMPUTERS AND OPERATING SYSTEMS. THE SOFTWARE

IS NOT WARRANTED FOR NON-COMPATIBLE SYSTEMS.

Call Novell Customer Support or your Dealer for information about
compatibility.

EXCEPT AS OTHERWISE RESTRICTED BY LAW, NOVELL
MAKES NO WARRANTY, REPRESENTATION OR PROMISE

NOT EXPRESSLY SET FORTH IN THIS LIMITED WARRANTY.

NOVELL DISCLAIMS AND EXCLUDES ANY AND ALL

IMPLIED WARRANTIES OF MERCHANTABILITY, TITLE OR
FITNESS FOR A PARTICULAR PURPOSE. NOVELL DOES

NOT WARRANT THAT THE SOFTWARE OR ASSOCIATED

DOCUMENTATION WILL SATISFY YOUR REQUIREMENTS

OR THAT THE SOFTWARE AND DOCUMENTATION ARE
WITHOUT DEFECT OR ERROR OR THAT THE OPERATION

OF THE SOFTWARE WILL BE UNINTERRUPTED. Some states

do not allow limitations on how long an implied warranty lasts, so

the above limitation may not apply to you. This warranty gives you
specific legal rights which vary from state to state.

EXCEPT AS OTHERWISE RESTRICTED BY LAW, NOVELL'S

AGGREGATE LIABILITY ARISING FROM OR RELATING TO

YOUR USE OF THE SOFTWARE, ASSOCIATED

DOCUMENTATION OR ANY SERVICES PROVIDED BY
NOVELL AND/OR ITS AGENTS IS LIMITED TO THE TOTAL

OF ALL PAYMENTS MADE BY OR FOR YOU FOR THE

SOFTWARE AND DOCUMENTATION . NEITHER NOVELL

NOR ANY OF ITS LICENSORS, EMPLOYEES, OR AGENTS
SHALL IN ANY CASE BE LIABLE FOR ANY SPECIAL,

INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE

DAMAGES EVEN IF ADVISED OF THE POSSIBILITY OF

THOSE DAMAGES. NEITHER NOVELL NOR ANY OF ITS
LICENSORS, EMPLOYEES, OR AGENTS IS RESPONSIBLE

FOR LOST PROFITS OR REVENUE, LOSS OF USE OF

SOFTWARE, LOSS OF DATA, COSTS OF RE-CREATING LOST

DATA, THE COST OF ANY SUBSTITUTE EQUIPMENT OR
PROGRAM. Some states do not allow the exclusion or limitation of

incidental or consequential damages, so the above limitation or

exclusion may not apply to you.
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PerfectOffice Professional
Software License Agreement

Introduction
The PerfectOffice suite and accompanying documentation

(respectively “Software” and “Documentation”) you have acquired

are protected by the copyright laws of the United States and

international copyright treaties. In addition, the possession and use
of the Software and Documentation is subject to the restrictions

contained in this License.

The component programs included in the PerfectOffice suite contain

various computer programs or files with different license rights. The

type of license that applies depends on the following definitions and
the permitted uses specified in the documentation accompanying the

Software. If this Software is an upgrade from a previous version of a

Novell software product, you may use either the current or prior

version of the Software, but never both versions at the same time. If
you use the current version, this License supersedes any prior version

license and governs your use of the Software. You may not transfer

the prior version separately from the current version without

permission from Novell.

Definitions
ALMs are dynamic loadable libraries (“DLLs”) that are used by
AppWare applications for specific functions.

ENVOY VIEWER AND DRIVER means the Driver that enables you

to create Envoy file forms from within other applications and the

Envoy Viewer that allows you to view and manipulate the Envoy file

forms.

ENVOY RUNTIME VIEWER means the viewer that when linked
with an Envoy file form enables a user to view the Envoy file form.

HELP FILES are files that explain how to use the AppWare

development environment or ALMs.

HEADER FILES, PROJECT FILES, CONFIGURATION FILES &

MISCELLANEOUS FILES are files that are useful for configuring

the AppWare development environment or AppWare applications, or
for compiling, linking or understanding the AppWare applications.

SAMPLE FILES are simple applications to show some of the

functionality of associated ALMs or otherwise included for

instructional purposes to show how to develop AppWare

applications.

OTHER DEVELOPMENT TOOLS are those files included in the
Software that permit applications to display or use the functions of a

particular piece of software such as QuickTime™ for Windows or

Crystal Reports™.

License Grants
WordPerfect, Quattro Pro, Paradox, InfoCentral, Envoy Viewer

and Driver, and Gateways
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive right to make and use up to the

number of copies of the Software and Documentation corresponding
to the “Quantity” designation on the Proof of Purchase form you

received in your PerfectOffice package.

Envoy Runtime Viewer
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive, royalty-free license to

distribute the Envoy Runtime Viewer as incorporated into an Envoy
file form developed using the Envoy Viewer and Driver, provided (a)

you do not use the logo, name or trademarks of Novell, (b) include a

valid copyright notice on media containing the Envoy Runtime

Viewer, and (c) agree to indemnify, defend and hold Novell and its

licensors harmless from and against any claims or lawsuits that arise
or result from use or distribution of the Envoy Runtime Viewer as

part of the Envoy file forms that you distribute. You are responsible

for all primary technical support to the end-users of any Envoy

Runtime Viewer you distribute. Envoy Runtime Viewer end-users
may receive technical support from Novell by calling 1-900-555-

7373. You may not reproduce or distribute the Envoy Viewer

without first purchasing the Envoy Commercial Publishing Pack.

GroupWise Client
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive right to (a) provided you do not
receive any direct payment, to make and distribute internally within

your organization an unlimited number of copies of the GroupWise

Client Software, and (b) use such copies of the GroupWise Client

Software to address and manipulate up to the number of mailboxes
corresponding to the “Quantity” designation on the Proof of Purchase

form you received in your PerfectOffice package.

GroupWise Message Server Software
Subject to the terms and conditions of this License Agreement,

Novell grants to you a non-exclusive right to (a) provided you do not

receive any direct payment, to make and distribute internally within
your organization an unlimited number of copies of the GroupWise

Message Server Software, and (b) use such copies to provide

GroupWise message services for a up to the number of domains

corresponding to the “Quantity” designation on the Proof of Purchase
form you received in your PerfectOffice package. A “domain” is a

logical grouping of post offices and/or gateways serviced by a single

message server.

AppWare
Subject to the terms and conditions of this License, Novell grants to

you (a) a non-exclusive, non-transferrable right to make and use up
to the number of copies corresponding to the “Quantity” designation

on the Proof of Purchase form you received in your PerfectOffice

package of the AppWare development environment, (b) a non-

exclusive, non-transferrable, royalty-free license to use Sample Files
to develop AppWare applications and copy and distribute the

resulting applications provided the resulting applications are

substantially more robust and have substantially greater functionality

that the Sample Files, and (c) a non-exclusive, non-transferrable,
royalty-free license to distribute those ALMs that are necessary for

applications developed using the AppWare development

environment solely in conjunction with the applications provided (i)

you do not use the logo, name or trademarks of Novell or the owner
of the ALMs necessary for execution of the applications, (ii) include

a valid copyright notice on media containing the applications, (iii)

agree to indemnify, defend and hold Novell and its licensors

(including the owners of the ALMs) harmless from and against any
claims or lawsuits that arise or result from use or distribution of the

applications, and (iv) none of the applications you distribute is a

software development tool that substantially competes with the

AppWare development environment. You may not copy or distribute
any other files, including Sample Files (as provided), Help Files,

Header Files, Project Files, Configuration Files, Miscellaneous Files

or Other Development Tools. You may not copy or distribute any of

the Documentation.
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General Provisions
Renting, Leasing, Timesharing & Reverse Engineering
You may not rent, lease, loan or timeshare the Software without the
prior written permission of Novell. You may not decompile,

disassemble, reverse engineer, or otherwise reduce the Software to a

human-perceivable form. You may not create or distribute the

Software or derivative works of the Software except as specifically
provided in this License.
Irrespective of the number of sets of media included with the

Software, you are granted the right to use the Software only
according the provisions of this License and the Proof of Purchase

form you have purchased. Certain qualifications may apply to the

purchase of this Software; when present, they are printed on the

Software package and form part of this License.

Home or Portable Computer Provision
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never loaded in

memory or virtual memory (Loaded) at the same time the Software is

Loaded on the primary computer on which you use the Software. If

you have licensed this Software under an education or charitable
institution pricing program, you may not create an extra copy of the

Software under this provision for use on a home or portable

computer.

Customer Support
Subject always to Novell’s current applications programs support

policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a

reasonable efforts basis only, and Novell may not be able to resolve

every support request. Novell supports the Software only if it is used

under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time

without notice.

Term
This License will become effective on the date you acquire the

Software and will remain in force until terminated. You may

terminate this License at any time by destroying the Documentation
and the Software together with all copies and adaptations. This

License shall also automatically terminate if you breach any of the

terms or conditions. You agree to destroy the original and all

adaptations or copies of the Software and Documentation, or to
return them to Novell upon termination of this License.

Entire License
This License sets forth the entire understanding and License between

you and Novell and may be amended only in a writing signed by both

parties. NO VENDOR, DISTRIBUTOR, DEALER, RETAILER,

SALES PERSON OR OTHER PERSON IS AUTHORIZED TO
MODIFY THIS LICENSE OR TO MAKE ANY WARRANTY,

REPRESENTATION OR PROMISE WHICH IS DIFFERENT

THAN, OR IN ADDITION TO, THE REPRESENTATIONS OR

PROMISES OF THIS LICENSE.

Waiver
No waiver of any right under this License shall be effective unless in

writing, signed by a duly authorized representative of the party to be

bound. No waiver of any past or present right arising from any
breach or failure to perform shall be deemed to be a waiver of any

future right arising under this License.

Severability
If any provision in this License is invalid or unenforceable, that

provision shall be construed, limited, modified or, if necessary,

severed, to the extent necessary, to eliminate its invalidity or
unenforceability, and the other provisions of this License shall

remain unaffected.

Export
Novell can only make the Software available pursuant to a valid

export license. Consequently, Novell will refund any fees paid to

you if it is unable to obtain an export license to ship the Software to
you. Your sole remedy for Novell’s failure to obtain an export

license is a refund. You hereby agree that you will not knowingly,

directly or indirectly, without prior written consent, if required, of the

Office of Export Licensing of the U.S. Department of Commerce,
Washington D.C. 20230, download, export, transmit or transfer the

Software or materials obtained via the Service to any group Q, S, W,

Y, or Z country specified in the Export Administration Regulations

issued by the U.S. Department of Commerce or to any country to
which such transmission is restricted by applicable regulations or

statutes.

US Government Restricted Rights
The Software and any accompanying materials are provided with

Restricted Rights. Use, duplication, or disclosure by the Government

is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The
Rights in Technical Data and Computer Software clause at DFARS

252.227-7013 or subparagraphs (c) (1) and (2) of the Commercial

Computer Software—Restricted Rights at 48 CFR 52.227-19, as

applicable. Contractor/manufacturer is Novell, Inc. at the address
below.

Questions?
If you have any questions concerning the terms of this License or

special programs for education or charitable organizations, please

write to WordPerfect, Novell Applications Group, Attn. Sales Center,

1555 N. Technology Way, Orem, Utah 84057-2399.
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Limited Warranty

This Software is licensed AS IS. If for any reason you are
dissatisfied with the software, return the product package, with proof

of purchase, to your reseller within 90 days for a full refund. If any

materials or media in this package are defective, return them to

Novell within 90 days of the date of purchase, and they will be
replaced at no charge. This refund is not available if the Software is

purchased as part of a Novell/Original Equipment Manufacturer

bundle.

THE SOFTWARE IS NOT DESIGNED, MANUFACTURED OR

INTENDED FOR USE OR RESALE FOR ON-LINE CONTROL
EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING

FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION

OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR

AIRCRAFT COMMUNICATION SYSTEMS, AIR TRAFFIC
CONTROL, DIRECT LIFE SUPPORT MACHINES, OR

WEAPONS SYSTEMS, IN WHICH FAILURE OF THE

SOFTWARE COULD LEAD DIRECTLY TO DEATH,

PERSONAL INJURY, OR SEVERE PHYSICAL OR
ENVIRONMENT DAMAGE.

THE SOFTWARE IS ONLY COMPATIBLE WITH CERTAIN

COMPUTERS AND OPERATING SYSTEMS. THE SOFTWARE

IS NOT WARRANTED FOR NON-COMPATIBLE SYSTEMS.

Call Novell Customer Support or your Dealer for information about
compatibility.

EXCEPT AS OTHERWISE RESTRICTED BY LAW, NOVELL

MAKES NO WARRANTY, REPRESENTATION OR PROMISE

NOT EXPRESSLY SET FORTH IN THIS LIMITED WARRANTY.

NOVELL DISCLAIMS AND EXCLUDES ANY AND ALL
IMPLIED WARRANTIES OF MERCHANTABILITY, TITLE OR

FITNESS FOR A PARTICULAR PURPOSE. NOVELL DOES

NOT WARRANT THAT THE SOFTWARE OR ASSOCIATED

DOCUMENTATION WILL SATISFY YOUR REQUIREMENTS
OR THAT THE SOFTWARE AND DOCUMENTATION ARE

WITHOUT DEFECT OR ERROR OR THAT THE OPERATION

OF THE SOFTWARE WILL BE UNINTERRUPTED. Some states

do not allow limitations on how long an implied warranty lasts, so
the above limitation may not apply to you. This warranty gives you

specific legal rights which vary from state to state.

EXCEPT AS OTHERWISE RESTRICTED BY LAW, NOVELL’S
AGGREGATE LIABILITY ARISING FROM OR RELATING TO

YOUR USE OF THE SOFTWARE, ASSOCIATED

DOCUMENTATION OR ANY SERVICES PROVIDED BY

NOVELL AND/OR ITS AGENTS IS LIMITED TO THE TOTAL
OF ALL PAYMENTS MADE BY OR FOR YOU FOR THE

SOFTWARE AND DOCUMENTATION . NEITHER NOVELL

NOR ANY OF ITS LICENSORS, EMPLOYEES, OR AGENTS

SHALL IN ANY CASE BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE

DAMAGES EVEN IF ADVISED OF THE POSSIBILITY OF

THOSE DAMAGES. NEITHER NOVELL NOR ANY OF ITS

LICENSORS, EMPLOYEES, OR AGENTS IS RESPONSIBLE
FOR LOST PROFITS OR REVENUE, LOSS OF USE OF

SOFTWARE, LOSS OF DATA, COSTS OF RE-CREATING LOST

DATA, THE COST OF ANY SUBSTITUTE EQUIPMENT OR

PROGRAM. Some states do not allow the exclusion or limitation of
incidental or consequential damages, so the above limitation or

exclusion may not apply to you.
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Introduction

Welcome to PerfectOffice 3.0—the first software suite that delivers on its promise to
fully integrate people, tasks, and software tools.

PerfectOffice is easy to learn and even easier to use. You’ll find the software you
need, open network integration, the flexibility to pick and choose your own integrated
applications, and a convenient way to build custom applications and add them to your
suite.

PerfectOffice offers new intelligent automation that goes beyond the simple features
found in most suite packages. The result? You’re free to focus on your work instead
of on the applications necessary to get it done. PerfectOffice will revolutionize the way
you look at software suites—and will let you effectively utilize your computer’s
capabilities.

What’s In
PerfectOffice 3.0?

PerfectOffice 3.0 is available in three different suite packages.

PerfectOffice Standard
The PerfectOffice Standard package features the following products:

• WordPerfect 6.1 for Windows, the world-renowned word processor unparalleled for
its versatility and functionality. WordPerfect integrates text, data, and graphics in a
single, easy-to-use program that you can completely customize to personalize the
way you work.

• Quattro Pro 6.0 for Windows, the perfect combination of spreadsheet power and
graphics. Quattro Pro simplifies your analysis, doing most of your work for you. It
helps you visualize numbers with graphics, and is easier to use than 1-2-3 or
Excel. Quattro Pro delivers spreadsheet power to PerfectOffice.

• Presentations 3.0 for Windows, an all-in-one solution to presentation graphics that
includes drawing tools, charting capabilities, and multimedia support. Use the
Outliner, Master Gallery, and Slide Sorter to create and organize your slide show,
then customize it with powerful drawing and painting tools. You can enhance your
slide show by adding video and animation clips, or inserting images from the
Presentations collection of more than 1,000 QuickArt clips.

• InfoCentral 1.1 for Windows, a revolutionary personal information manager that
lets you quickly organize and access information. You can create intelligent
connections between people, places, and things; organize your personal address
book; store vital information about business contacts; list upcoming events; keep
track of school notes; manage your home video collection; or complete other tasks
that interest you.

• Envoy 1.0a for Windows, a workgroup publishing tool that lets you electronically
view, annotate, and distribute documents, complete with color and graphics,
across the network. You can view the document, copy text and graphics, search
for text, make annotations, rearrange pages, and route and print documents—all in
files that are half the size of those in competing technologies.

• GroupWise QuickLook for Windows, a demonstration version of GroupWise Client,
Novell’s electronic messaging software. The QuickLook version is intended to help
you evaluate the GroupWise client software, which integrates e-mail, calendaring,
group scheduling, and task management into PerfectOffice. See Sharing
Information Using PerfectOffice for information about installing GroupWise
QuickLook.
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PerfectOffice Professional
In addition to all the components offered in the Standard package, PerfectOffice
Professional gives you the following products:

• Paradox 5.0 for Windows, a relational database that serves as both an OLE client
and server for full database integration. New functionality and enhancements have
been added to this program to make Paradox easier to use and understand.

• AppWare for Windows, a visual application development program that lets you
create everything from simple tasks to complex applications. AppWare provides a
5th generation visual development environment for custom applications.

PerfectOffice Select CD-ROM
The Select CD-ROM lets you create your own suite solution by choosing from among
any of the applications and consumer products included on the CD. All the
applications in the Standard and Professional packages are included on CD-ROM,
along with various Novell GroupWare™ applications, WordPerfect Main Street™

applications, and third-party applications technologically integrated for this suite.

How Does It All
Work Together?

PerfectOffice is the only suite on the market to feature PerfectFit™ technology, a
common code base shared by all the suite components. What this means to you is
unparalleled program integration. You’ll see the same interface, use the same tools,
and easily automate tasks for all applications in the suite.

Common User Interface
All of the applications in PerfectOffice share consistent toolbars, pull-down menus,
and common dialog boxes. Once you know one application, you can be productive in
all of them. Also, because each PerfectOffice program looks and feels the same,
you’ll find it easy to switch among any of the applications in your package.

Common Tools
The code base shared by all PerfectOffice applications provides the most extensive
set of common suite tools in the industry. Most of the applications in the suite share a
file manager, drawing module, and thesaurus, as well as the following:

• QuickCorrect, which automatically corrects spelling as you type.

• Find and Replace, which features PerfectSense™ technology, the first linguistic
technology that actually understands the meaning of words and their different
forms. If you want to replace the word purchase with the word buy, for example,
PerfectSense automatically replaces purchased with bought.

• Grammatik™ 6.0, which features an intelligent find-and-replace function and the
ability to rewrite entire sentences.

• Coaches and Experts, which provide electronic hands-on help and interactive
instruction for the most common tasks, both in individual applications and across
applications.

• DragonDictate® Talk To™ PerfectOffice speech-recognition system, which lets you
operate PerfectOffice applications by speaking into a microphone. This system is
included only in the CD-ROM version of PerfectOffice. A sound card and a
DragonDictate microphone are required. See the online Help or contact Direct
Sales (Appendix A: Customer Services) for more information.

Common Suite Manager
The Desktop Application Director (DAD) is a toolbar that lets you easily switch among
all the suite applications. You can customize DAD in a variety of ways. You can also
place non-suite applications on DAD for quick access. You can configure DAD as
either a toolbar or a palette, and can place it anywhere you want on the screen—
wherever you find it most convenient. You can even hide DAD until you need to use
it. See Using the Desktop Application Director (DAD) for a complete overview of the
suite manager.
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Support for OLE 2.0
PerfectOffice offers Object Linking and Embedding (OLE) 2.0 functionality in more
applications than any competing suite, which makes sharing information between
programs simple. With OLE 2.0, you can drag and drop data and edit objects in place
among the PerfectOffice programs. Placing a Quattro Pro chart in a WordPerfect
document, for example, is as easy as dragging the chart directly from one program
window to the other. Then, by double-clicking on the embedded spreadsheet, all of
the functions of Quattro Pro are available from the WordPerfect pull-down menus and
toolbars, so you never have to leave your WordPerfect document to edit the
spreadsheet.

OLE functionality is also found in the PerfectOffice database Paradox, which serves
as both an OLE container and server, providing full database integration.

OBEX Technology
Object Exchange (OBEX) lets you easily share information among the people in your
workgroup. You simply “publish” information you want to share, and members of your
workgroup “subscribe” to that information with the capability of incorporating it directly
into their documents. Every time you update your data, their subscriptions are
automatically updated to reflect your latest information. For more information about
OBEX, see Sharing Information Using PerfectOffice.

Automated Computing Tasks
PerfectScript™ technology offers the first scripting language in a suite that lets you
record a task involving more than one application and play it back. In other words,
PerfectOffice gives you the ability to automate computing tasks across all
PerfectOffice applications.

QuickTasks™ • Accessible from DAD, QuickTasks™ automatically perform both
simple and complex tasks directly from the desktop—without requiring that you
open individual applications. With QuickTasks, you can concentrate on what
you’re doing instead of worrying about which application you’re in.

You can automatically create letters, faxes, spreadsheets, and slide shows; update
PIM records; schedule meetings; open e-mail; generate mail merges; and perform
other common tasks right from the PerfectOffice desktop. You can even perform
tasks that use multiple applications in a sequence.

PerfectOffice ships with a variety of pre-defined QuickTasks ready for you to use
(see Appendix C: QuickTasks for a list of QuickTasks included with the suite). In
addition, you can add your own QuickTasks to DAD to customize the suite to fit
your needs.

QuickTools • PerfectOffice contains a variety of automation tools to help you
quickly accomplish common tasks. For example, QuickCorrect automatically
corrects misspelled words as you type. QuickCorrect is available in several
PerfectOffice applications—not just in WordPerfect. Other Quick Tools available
throughout the suite include QuickFormat, QuickList, QuickFinder, QuickMenus,
and QuickHelp. For more information about QuickTools, see online Help.
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Installing PerfectOffice

System
Requirements

• Personal computer using a 386 or higher processor (a 486 system is recommended)

• 8Mb RAM

• Hard disk with 45Mb (minimum) to 98Mb (maximum) of available disk space for the
PerfectOffice Standard package, or 68Mb (minimum) to 138Mb (maximum) of available
disk space for the Professional package

• An additional 6Mb to 10Mb of hard disk space for temporary files (this space becomes
available again after installation)

• VGA or other high-resolution display supported by Microsoft Windows

• Windows 3.1 or higher, or Microsoft Windows for Workgroups

• Mouse or other Windows pointing device

IMPORTANT: The amount of hard disk space you need depends on the number of
applications and optional features you install.

Installing
PerfectOffice on a
Hard Disk

The PerfectOffice files are compressed on disks. To install PerfectOffice, you must use
the setup program. This applies whether you’re installing PerfectOffice for the first time or
as an upgrade to Borland Office 2.0 for Windows.

IMPORTANT: When installing PerfectOffice, you should ignore the installation instructions
contained in the individual product manuals.

If you have questions before you install, refer to Questions and Answers about Installing
later in this section.

To install PerfectOffice on your hard disk,

1 Start Windows if you have not already done so.

2 Insert the Setup disk into drive A (or drive B).

3 Choose Run from the File menu in the Windows Program Manager.

4 Type a:setup (or b:setup), then choose OK.

Install button
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5 Choose Install.

Type your name.

Type your PerfectOffice serial

number.

6 Type your name and PerfectOffice serial number, then choose Continue.

7 Select an installation type, then follow the on-screen prompts to finish installing
PerfectOffice. (You will be able to install to any drive you want.)

We recommend a Standard installation for most users.

For information about the installation options, refer to the table under Questions and
Answers about Installing later in this section. If you have additional questions about
installing, use the online Help system included with the setup program by choosing Help in
any of the Install windows.

IMPORTANT: When you have finished installing the program on your hard disk, put the
original disks in a safe place. Avoid exposing them to sunlight, dust, and magnetic fields
(even televisions, telephones, and stereo speakers contain magnets).

Installing
PerfectOffice on a
Network

For information about installing PerfectOffice on a network, see Appendix B: Networking
PerfectOffice.

Questions and
Answers about
Installing

I’m already using some of the programs included in PerfectOffice. Do I need to
delete these programs before installing PerfectOffice?
It depends on the application version you are currently using. If you are already using the same
version of a program included with the suite, you do not have to delete it before installing
PerfectOffice. For example, if WordPerfect 6.1 is already installed, you do not have to delete it
before installing the suite. During installation, the setup program replaces any existing copies of
PerfectOffice applications on your hard disk. While the preferences you made to those programs
might be lost, existing documents, graphics, and macros will remain intact.

If you are using an earlier version of an application included in the suite, such as
WordPerfect 6.0, you may choose to delete it to save disk space. During a standard
installation, the setup program detects any earlier application versions you are currently
using, such as WordPerfect 6.0, and asks you if you want to replace them with

Installing PerfectOffice 15



PerfectOffice versions. If you want to keep the version you are currently using, you can do
so by choosing a Custom installation and specifying an alternative directory structure.

Which installation option should I choose?
The standard installation is the recommended installation type for most users. The
following table describes each installation type.

Installation Type Use

Standard To install PerfectOffice for the first time or to replace Borland
Office 2.0 for Windows

Custom To customize your installation by installing only part of the
program or sets of files to directories you specify

Network To install PerfectOffice for use by users on a network server or
workstation

Minimum To install the minimum files necessary to run PerfectOffice

(The setup program omits files needed for optional features.)

Options To install printer drivers, fonts, the Utilities disk, or to view
README files

When I install PerfectOffice, a prompt tells me that I don’t have enough room to
install all files. What should I do?
Exit the setup program and delete unnecessary files from your hard disk to make more disk
space available. You can also use the Custom or Minimum installation options. Custom lets you
install individual files. (Use this option only if you know exactly which files you need.) Minimum
omits the files needed for optional features and installs only those files necessary to run
individual programs.

How can I conserve disk space?
Choose Minimum installation to install only the files necessary for running PerfectOffice.
This option requires a minimum of 45Mb of free disk space, and does not install optional
features such as predefined toolbars, the QuickLook version of GroupWise, or any Help
files.

Which directories were installed?
PerfectOffice files are organized into subdirectories under the root directory \OFFICE. The
recommended directory structure for PerfectOffice is shown in the diagram below. This is the
directory structure used for a standard installation. If one of these directories already exists on
your hard disk, all duplicate files in that directory except for those you have created or modified
will be copied over during installation.

OFFICE
 

      WPWIN 

      PRWIN 

      QPW 

      SHARED 

                WPC20 

                TEXTART 

                TASKS 

                OBEX 

                IDAPI 

      GW_DEMO 

      WPIC 

      ENVOY 
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Subdirectory What it contains

WPWIN WordPerfect 6.1 program files and subdirectories

PRWIN Presentations 3.0 program files and subdirectories

QPW Quattro Pro 6.0 program files and subdirectories

SHARED Subdirectories \WPC20 (PerfectFit files for shared components such
as the Speller, Thesaurus, and so on), \TEXTART (TextArt program
files), \TASKS (DAD QuickTask files) \OBEX (files for Object
Exchange technology), and \IDAPI (cross-application, database-
conversion support files)

GW_DEMO GroupWise QuickLook program files

WPIC InfoCentral 1.1 program files and subdirectories

ENVOY Envoy 1.0a program files and subdirectories

I accidentally deleted some PerfectOffice program files. Can I reinstall only part of
PerfectOffice?
Yes. Start the PerfectOffice setup program, choose Custom installation, then select the
files you want to reinstall. (You cannot recover lost personal files or documents using the
setup program.)

How can I remove PerfectOffice 3.0 from my computer?
The setup program includes an Uninstall option that allows you to remove some or all of the
PerfectOffice applications from your computer. From the Program Manager in Windows,
double-click the PerfectOffice Setup icon. Choose Uninstall, then select the applications want
removed. Files you created or modified will not be removed.
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Getting Help

Each application in PerfectOffice comes with an advanced online Help system. When you
need information, online Help is your best solution. Help appears in a separate window on
your screen. For quick access, you can keep the Help window displayed on top of the
application you’re working in. It’s convenient, sensibly organized, and structured in a way
that makes finding the information you need quick and enjoyable.

If you need assistance beyond what the online Help system and printed manuals provide,
you can call Customer Support or use one of the other customer support services provided
by Novell (see Appendix A: Customer Services).

Using Context-
Sensitive Help

Help is context sensitive, which means you can access Help wherever you are in the
program, including menus and dialog boxes.

1 Place the pointer on the item you want information about, then press F1.

Using Online Help This section introduces you to the basic components of online Help.

IMPORTANT: While most of the Help components described in this section are available in
all PerfectOffice applications, a few are not. Components may also differ slightly
depending on the Help system. For information about a specific online Help system, see
the Getting Help section in the documentation included with that product.

Use Contents to access the main components of Help. You can think of it as the table of
contents of Help.

1 Choose Contents from the Help menu.

Icons help distinguish the

components of Help.

2 Click the Help icon you want.

Each Help icon is explained below.

Getting Help 18



How Do I
When you need information about performing a specific task, use How Do I. The
information in How Do I is organized into books, chapters, and pages and is displayed in
an expandable outline.

Click a book to view

the chapters.

Click a chapter to view the

tasks.

Click a task to read the Help

topic.

Help topic

To find steps for performing a specific task, start at the book level. Each book listed in
How Do I represents a category of tasks.

1 Click a book to open it.

Chapters contain specific tasks, or pages. (Some books contain only pages.)

2 Click a chapter to see the list of pages.

The pages represent individual Help topics.

3 Click a page to see the corresponding Help topic.

Clicking an open book or chapter closes it. Clicking Open Books at the top of the How Do
I window displays all levels of How Do I (books, chapters, pages). Clicking Close Books
closes all books, leaving only book titles displayed.

Search for Help on
Use Search for Help on to find information by typing in a feature name, a keyword, a
synonym, or a phrase. If you are using Quattro Pro, click the Search button at the top of
any Help window.

1 Type a keyword or phrase for the subject that interests you.

Possible keywords appear

here.

2 Select a keyword from the keywords list, then choose Show Topics.
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A list of related Help topics appears in the lower part of the dialog box.

Topics list

3 Select a topic from the topics list, then choose Go To.

Examples
Examples is a collection of sample documents that illustrates some of the capabilities of
the program. It’s also a powerful Help tool that lets you search for and locate information
visually instead of textually. You can find information about a specific feature or task
without knowing the correct terminology.

Collection of examples

Triangle arrow

Help topic describing the

document or an element in

the document

1 Click an example from the collection.

Triangle arrows label and define the various elements in the document.

2 Click a triangle arrow pointing to the element that interests you.

A Help topic appears on the right side of your screen describing that element of the
document.
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Additional Help
Additional Help contains supplementary information such as Tips and Tricks, Customer
Support, Glossary, Keystrokes, Common Questions, What’s New, Available Products, and
other useful information.

Click a letter to display a list of

program terms.

Click a term to display a pop-up

definition.

Macros
Macros contains a comprehensive list of macro commands with a description of how to
use them. It also includes information about recording and playing your own macros.

Using Help
This section describes the elements of a Help topic (jump terms, pop-up definitions, icons),
and shows you how to use them.

Click dot-underlined text to

view a pop-up definition.

Click underlined text to "jump"

to another topic.

Click the light-bulb icon to

view a hint.
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Coaches
Use Coaches to learn how to perform specific tasks. The Coach guides you through a task
one step at a time.

1 Choose Coaches from the Help menu.

A description of the

highlighted Coach appears

here.

2 Select a Coach, then choose OK.

3 Follow the on-screen prompts to complete the task.

Upgrade Expert
Use Upgrade Expert to compare feature names with those used in competitors’ products,
or to compare terms in the current version of your program with those used in a previous
version. In addition, Upgrade Expert can show you how to access features from pull-down
menus. You can also use it to apply features to your current document.

1 Choose Upgrade Expert from the Help menu.

Drop-down list containing

other applications

Feature names

Click Show Me to see the

feature displayed.

Click Do It to see the feature

used in your document.

2 Select an application from the drop-down list.

3 Select a feature.

The function of each button at the bottom of the screen is explained below.

Button Description

Show Me Demonstrates the selected feature
Do It Applies the feature to your current document
Coach Leads you step-by-step through the task
More Help Displays a Help topic about the feature
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Displaying Help Always on Top
For quick access, you can keep the Help window open on top of the application you’re
working in until you exit.

1 Choose Always on Top from the Help menu in the Help window.

When you click the document window, the document becomes active, but the Help window
remains on top.

HINT: You can size and drag the Help window to see the area of the document you are
working on.

Printing Help Topics

1 Choose Print Topic from the File menu in the Help window.

or

Click the Print button in the Help window.

HINT: Depending on the program you are using, you may be able to print multiple Help
topics through Additional Help. If you are using Quattro Pro, you can print multiple Help
topics by choosing Print Group of Functions or Print Group of Macros from the File menu
in the Help window.

Customer Support For information about Customer Support, see Appendix A: Customer Services.
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Using the Desktop Application Director (DAD)

The Desktop Application Director (DAD) is a toolbar that functions as the suite
manager. Use DAD buttons to launch applications and perform simple and complex
tasks right from the PerfectOffice desktop. You can play keyboard scripts and macros
in any of the suite applications, manage and run files, and even exit Windows. You
can customize DAD in a variety of ways to fit your needs.

In short, DAD provides you with powerful integration tools to help you use and take full
advantage of the programs in the suite.

Starting DAD During installation, a DAD icon is created and placed in the Startup program group.
Unless you move the icon, DAD will start automatically each time you start Windows.

Desktop Application

Director (DAD) with buttons

displayed as picture and text

To start DAD if it is not currently running,

1 Double-click the Desktop Application Director icon.

Selecting a DAD
Bar

PerfectOffice includes three DAD bars to enhance your productivity when using the suite.
The PerfectOffice DAD bar provides you with the basic tools you need to run the suite and
integrate the applications; the tools on the Data Sharing DAD bar simplify the process of
sharing information between applications; and the Control Panel DAD bar gives you direct
access to the settings that control your Windows system configuration.

You can select one of the DAD bars included with PerfectOffice, or you can create your
own. (For information about creating DAD bars, see Creating Your Own DAD Bar later in
this section.)
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1 Right-click DAD, then choose the DAD bar you want.

The DAD bar you choose remains selected until you choose another one.

Moving DAD on
Your Screen

You can display DAD as a toolbar or palette and place it anywhere on your screen.

DAD bar positioned on the

right side of the screen

DAD bar displayed as a

palette

1 Place the pointer on a blank area of the DAD bar.

When the shape of the pointer changes to a hand,
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2 Drag the bar anywhere on the screen.

Choosing Display
Options

You can specify the position, appearance, and characteristics of DAD to fit your needs.
You can even hide DAD until you need it in order to save screen space.

1 Right-click DAD, then choose Preferences.

2 Choose Display.

Select Picture and Text to

clarify DAD buttons Select Always in Front to overlay

DAD on open applications.

3 Select the appearance and location options you want.

4 Select a display option. Each option is explained below.

Option Description

Always in Front Overlays DAD on top of open applications

Auto Hide Also called “DAD on demand,” this option hides DAD when you
are not using it. To redisplay DAD when it is hidden, move the
pointer to the edge of the screen where DAD is positioned. Auto
Hide will not hide DAD when it is configured as a palette.

Normal Lets other applications overlay DAD

5 Choose OK.

Using the
PerfectOffice DAD
Bar

The buttons on the PerfectOffice DAD bar provide you with the basic tools you need to
launch and integrate the applications in the suite.

The PerfectOffice DAD bar also lets you perform basic display operations, set DAD
preferences, display an MS-DOS Prompt, exit DAD, and even exit Windows. In addition,
the bar gives you quick access to various Help sources such as the PerfectOffice
QuickTour, the DAD Coach, and the DAD online Help system. But perhaps the most
valuable buttons on the PerfectOffice DAD bar are those which access some of the suite’s
automation features—QuickTasks, QuickFiles, QuickRun, and QuickOpen.
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